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Customer Application Development Flow

Here, the flow for customer application development is described. nRF5 SDK provided by Nordic

includes various sample software. Based on this, customer's application can be developed for
customer's specification, function addition and modification. Moreover, LAPIS Technology
provides the original sample software, and refer to also here.

Base Sample Software Selection
STEP 1 Introduce the sample software.
[ ]

The customer's application can be efficiently developed
by selecting near sample software. Go >»>

~_=

Software Development Environment Construction

STEP.2

The software development environment of compiler and
the debugger are prepared. Go »

~_=

Customer's Application Development
STEP-3 After the software development environment is prepared,

actually, let's start the software development.
Introduce the usage the development tools. Go >>
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Step.1 Base Sample Software Selection

Step.1-1 Sample Software Selection

LAPIS Technology provides the sample software shown in the following table (some under
development).
Customers can modify freely and use free of charge.

Table. Sample Software Provided by LAPIS Technology

Software for ® Enables Bluetooth low energy Refer to the LAPIS
serial wireless communication easily Technology's wireless
communication using simple AT commands. support site.

® Using this sample software, the  https://www.lapis-semi.co

devices which have been m/cgi-bin/MyLAPIS/regi/|

controlled via UART can be made ogin.cgi
wireless easily.

Software for remote @ This can be used for a Bluetooth = Refer to the LAPIS
control low energy wireless remote Technology's wireless
control. support site.
https://www.lapis-semi.co
m/cgi-bin/MyLAPIS/regi/|

ogin.cgi
Software for ® This can be used for an Expected to be disclosed in
sensing and logging application that collects data by = March 2021.

sensing various types of

sensors/devices.

Nordic provides various types of sample software. The following introduces some of them.
The following table shows the sample software provided as application examples with nRF5
SDK v17.0.2. In addition, a throughput measurement application, current consumption
measurement application, multi-protocol application, etc. are provided as evaluation
applications.

[Note] The amount of memory used by SoftDevice varies depending on the type of
SoftDevice (Bluetooth low energy protocol stack library provided by Nordic). Therefore,
some combinations of the sample software and SoftDevice do not work for MK71511.
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Table. Sample Software Provided by Nordic (Classified by Application)
GAP Role SoftDevice
| @
Application Sample software summary Sls_| ¥ 8 8
5 = © - bl -
3 g 0wl u| n
o Button side for LED application. ° (] (]
LED Lighting - ——
LED side for LED application. () ) o
Beacon application for iBeacon. ) e o | o
Beacon application for Eddystone. ) e |0
Beacon Beacon for Bluetooth standard. When button is pressed, it transits
from System-Off state, and start to transmit the advertising ° ° ° °
packet.
Lost article Tracker | Node application for Tile. OTA function Tile is had. ) e o | o
Serial Button side of multi-connection application between one button ° ° °
communication device and some LED devices.
. . Button side of multi-connection application between one button ° ol o
I\/IlL.lllfll—connectlon device and some LED devices.
(1:N) LED side for LED application. ° o | o | @
Multi-connection Buttor.1 side for L_ED appllcgtlon. _ _ ° C )
(N:1) LED side of multi-connection application between one LED device ° ol ol o
and some button devices.
Multi-connection Multi-connection application for UART command application.
for UART Advertise", "connect", "disconnect" and etc. are controlled by an ) () ® ®
Command I/F original command.
The collector receives data from Heart rate monitor, Running
Speed and Cadence (RSC) sensor, switches function to sensor ) ) o | 0
Data Relay (peripheral) and it is relayed to smartphone.
RSC profile for sensor side. ) o | o0
Heart rate monitor profile for sensor side. () ° °
Pairing using NFC. Central side. ° °
NFC Pairing Pairing using NFC. Legacy pairing (JW), Legacy pairing (OOB), and
Secure connection (OOB) can be selected with the push-button. ) [ )
The smartphone with NFC can be used for the peer device.

The following table shows the sample software provided as application examples of
Bluetooth standard profiles with nRF5 SDK v17.0.2.
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Table. Sample Software Provided by Nordic (Classified by Profile)

GAP Role SoftDevice
Bluetooth GATT | @
. Sample software summary Els_| o 8 2
Base Profile c | 2®| S| o =
[} 0wl u| n
| &
Data collector side for Heart Rate Profile. The heart rate data is ° ° °
Heart Rate received, and output it via UART.
Sensor side for Heart Rate Profile. ° )
Collector side for Heart Rate Profile. The heart rate data is ° °
Heart Rate received, and output it via UART. NFC pairing version.
(+ NFC Pairing) Sensor side for Heart Rate Profile. NFC pairing version. () ) o o
Sensor side for Heart Rate Profile. Ferrets version. ) o
Blood Pressure Server for Blood Pressure Profile. The blood pressure simulation ° ° ° °
data is transmitted by push-button.
Glucose Sensor side (Server) for Glucose Profile. Glucose data is created by ° PO P
push-button.
Health Sensor side for Health Thermometer Profile. Thermometer ° PO R
Thermometer simulation data is transmitted by push-button.
Continuous . . o )
Glucose Sensor side for Continuous Glucose Monitoring Profile. ) e o | o
Collector side for Running Speed and Cadence Profile. The data is ° ol o
RunNing Speed received, and output it via UART.
and Cagenpce Sensor side for Running Speed and Cadence Profile (RSCP). The
simulation data for RSCP and Battery Service are transmitted ) o | o0
periodically.
Cycling Speed and | Sensor side for Cycling Speed and Cadence Profile (CSCP). The ° o | o
Cadence simulation data for CSCP and Battery Service are transmitted.
o Reporter side for Proximity Profile and locator side for Fide Me
Proximity Profile ° ° ° °
Reception side of Immediate Alert Notification. Peripheral device of
ISA is connected by pairing (JW), it can try until max. device ° ol o
Immediate Alert number of multi-connections. When the Immediate Alert Service is
received, LED3 is indicated.
Transmission side for Immediate Alert Notification. At pressing the °
button, the alert level does toggle in order of 0->1->2->0.
Link Loss Reporter for Link Loss Service. ° o | o | @
Alert Notification Reporter for Alert Notification Profile. Alert is notified to ° ° ° °
smartphone by pressing the button and status is indicated to UART.
Current Time Client side for Current Time Service. Time data is received by ° e ol o
pressing the button and it is indicated to UART.
o Initiator for Indoor Positioning Profile. [ [ )
Indoor Positioning — -
Acceptor for Indoor Positioning Profile. ) [ )
Location and Server side for Location and Navigation Profile. The control from ° o | o
Navigation client side is output to UART.
Keyboard application for Human Interface Device (HID) over GATT ° PO A
profile. "hello" character is transmitted by pressing the button.
Human Interface — -
Device Mou_se appllcatlon_ for Human Interface Device (HID) over G_ATT
profile. Mouse pointer is moved to Upper, Lower, Left and Right. ) e (o | o
Apply Swift pairing (Simple pairing) function.
. Client side for Object Transfer Service (OTS). [ o | o0
Object Transfer - - -
Server side for Object Transfer Service (OTS). ° C )
Bond Management | Server for Bond Management Service. ° ° °
Client side for Nordic UART Service (NUS). It automatically ° ° °
Nordic UART connects to peripheral device of NUS.
Nordic UART Service (NUS) is controlled on console by Python
script. d e e
Apple Notification Client side for Apple Notification Center Service (ANCS). ° PO P
Center Button operation and status is indicated to UART.
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Step.1-2 Downloading & Installing Nordic nRF5 SDK
Sample software provided by Nordic is bundled to nRF5 SDK provided by Nordic.

NRF5 SDK can be obtained free of charge via the following link.

Unzip the downloaded ZIP file to the arbitrary folder.
[Note] Do not use a long path in the deep hierarchy or a name containing double-byte
characters for the folder where the file is unzipped.

Step.1-3 Installing LAPIS Technology's Sample Software

If the sample software provided by LAPIS Technology is selected at Step.1-1, copy the
software downloaded from the LAPIS Technology's wireless support site to the folder where
the nRF5 SDK file was unzipped. For the folder to unzip the file, refer to the instruction
manual of the sample software.

If the sample software provided by Nordic is selected, proceed to Step.2-4

Step.2 Software Development Environment Construction

Step.2-1 Selecting Software Development Environment

The following development tools can be used as the software build environment.
Segger Embedded Studio, which can be used free of charge, is recommended for the
software development for Nordic chips.
The following part describes environment construction using Segger Embedded Studio as
an example.

* SEGGER Embedded Studio

«  Arm® Keil® MDK

* IAR Embedded Workbench (EWARM)

* (gcc

Step.2-2 Installing Segger Embedded Studio
Download Segger's IDE (Integrated Development Environment) "Embedded Studio for

ARM" via the following link. This application is a tool to build and debug the software
created by a customer. To write a HEX file after a build, proceed to Step.2-4.

Execute the downloaded installation file. Perform the installation following instructions from
the installer, and Embedded Studio and J-Link Device Driver will be installed.
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Step.2-3 Activating Segger Embedded Studio

To use Segger Embedded Studio, activation (license authentication) is required first. When
Embedded Studio is started for the first time, the following window appears to notify that
license authentication has not been done. The [Continue] button is pushed in this window.

%2 SEGGER Embedded Studio V5.20a ? >

9

No commercial-use license detected

Embedded Studio could not find a commercial-use license on this computer or any attached J-Link.

If vou would like to evaluate this software or use it for educational or other non-commercial purposes, you
are welcome to do so by clicking Continue.

If vou do have a commercial-use license, but that license is temporarily unavailable, please continue to use
Embedded Studio as if it were present and click Continue.

‘Would you like to use Embedded Studio for commercial purposes?
Once you finish evaluation and decide to use Embedded Studio for your commercial purposes you have to
obtain a license.

-+ Read the License Agreement
= Obtain a License

Continue Close

Figure. Initial Window Prompting User to Perform Activation

The activation can be done from the following link.

MK715x1 is equipped with a Nordic chip, and therefore the free license applies. For this detail,

refer to the following link.

Free License

After entering the required items in the following activation window, the [Request License]
button becomes active. Click the button. The activation key will be sent to the specified
email address.

[Note] An error may occur when "Co., Ltd." is attached to the company name.
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»\_ Embedded Studio
/SEGGER

License Activation

Please fill in the form below to request your Embedded Studio
License Activation for Nordic Semiconductor Devices.

a First Name

6 Last Name
h Company
9 E-Mail Address

MAC (33X:XXXX XX XX XX)

E [ Yes, I have read and do accept SEGGER's Privacy Policy.

Server powered by

LR G-I

© 2017-2019, www.seqger.com, Al rights reserved.

Figure. Activation Window

For the entering MAC address, the MAC address of the PC used needs to be checked and
entered. Select [Tools] -> [License Manager...] from the Embedded Studio menu and then
select [Diagnose Problems] in the [License Manager] window to check the MAC address of
the PC used.

Tools  Window  Help
£ Options... Alt+, ‘

License Manager...

Packa| © SEGGER Embedded Studio for ARM V4.30c - License Manager ? X

) Show What do you want to do?

Manu

o=
6 Newf I No installed sctivation
Mew B

Brows| =¥ Activate Embedded Studio

%> SEGGER Embedded Studio for ARM V4.30¢ - License Manager 7 X

@ Diagnose Problems
| have received my license key and want to activat
Termi

< Manage Adtivations SEGGER Embedded Studio for ARM 4.30c on Windows

| want to manage my installed Embedded Studio 3

Adrmi

List of detected Ethernet adapters

-) Diagnose Problems Ethernet Adapter

I've been asked to send a license report to help dis|  Name: Intel(R) Ethernet Connection 1219-V
® MAC Address:

Ethernet Adapter

® Name: Bluetooth Device (Personal Area Network)
® MAC Address:

Ethernet Adapter

® Name: Intel(R) Dual Band Wireless-AC 8260
® MAC Address:

Ethernet Adapter

® Name: Microsoft Wi-Fi Direct Virtual Adapter
® MAC Address:

Back Close

Figure. MAC Address Confirmation Window
Copy the activation key specified in the email sent from Segger with Ctrl + C. Select [Tools]
-> [License Manager...] from the Embedded Studio menu and then select [Activate
Embedded Studio] in the [License Manager] window. The [License Manager] window will be
displayed with the activation key entered. Click the [Install License] button located in the
lower left section.
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Tools  Window  Help
£ Options... Alt+,

License Manager...

Packal & SEGGER Embedded Studio for ARM V4,30c - License Manager ? X
R Do What do you want to do?
Manu
% SEGGER Embedded Studio for ARM V4.30c - License Manager ? X
A M
ew F . - . .
(i I No installed activation @ Activate Embedded Studio
New B
Brows <P Activate Embedded Studio Enter activation key:
| have received my license key and Please check your e-mail client's inbox for an activation key.
Termir
Adrmir <> Manage Activations
| want to manage my installed Emb
=» Diagnose Problems
I've been asked to send a license rep
< >

Activation key status:
Product: Embedded Studio for Cortex-M V4

Ethernet MAC Address Lock:

SUA Expiration Date: & 2 5 2021

Back Close

Figure. License Key Input Window

When the license installation is performed successfully, the following window is displayed.

%» SEGGER Embedded Studio for ARM V4.30c - License Manager T x

@ Manage Activations

Installed licenses:
Product
4 Product: Embedded Studio for Cortex-M V4
Ethernet MAC Address Lock: =7 77 77 70 0T 00
SUA Expiration Date: & 2 5 2021
Licensed to: 7 - Lapis ©
Wender: Nordic Semi

Remove License|

Back Close

Figure. Window Displayed after License Key Input

The display at the top of the Embedded Studio window also shows that the license has been
obtained as shown below.
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%* SEGGER Embedded Studio for ARM V4.30c {54—bit]l» Mon-Commercial License l

File  Edit View  Search Navigate  Project  Build Debug Target  Tools Window Help

‘ After Activation

> SEGGER Embedded Studic for ARM V4.30c [64-bitﬁ[— Licensed to - Lapis ]

File  Edit  View  Search  MNavigate Project Build Debug  Target TJools  Window  Help

Figure. Display Examples before and after Activation

[Note] There may be a case that the display at the top of the Embedded Studio window
does not change from "Non-Commercial License" after activation. In this case, license
authentication will be reflected by opening the sample software project (for example, the
following project) included in nRF5 SDK installed in Step.1-2. For how to open the project
file, refer to Step.3-1. "<nRF5 SDK>" indicates the path to the folder where nRF5 SDK was
installed.

[Example]
<nRF5 SDK>¥examples¥ble_central¥ble_app_blinky_c¥pcal0040¥s132¥ses¥

ble_app_blinky_c_pcal10040_s132.emProject

Step.2-4 Installing nRF Connect for Desktop

Download Nordic's development application "nRF Connect for Desktop" via the following
link. The "Programmer" in "nRF Connect for Desktop" is a tool to write an application or
SoftDevice to the Flash ROM mounted on MK715x1 and delete or verify it.

Execute the downloaded installation file. "nRF Connect for Desktop" is installed, and it is
started automatically. Next, execute the installation of "Programmer" with the "Install"
button of "Programmer" of "nRF Connect for Desktop".

MK715x1 Software Development Flow (Rev.04 Nov. 30, 2020) 9


https://www.nordicsemi.com/Software-and-tools/Development-Tools/nRF-Connect-for-desktop
https://www.nordicsemi.com/Software-and-tools/Development-Tools/nRF-Connect-for-desktop
https://www.nordicsemi.com/Software-and-tools/Development-Tools/nRF-Connect-for-desktop

MK71511/MK71521

Step.3 Customer's Application Development

Step.3-1 Coding Application Program

Using Embedded Studio installed in Step.2-4, perform coding of an application. To use the
sample software as it is, proceed to Step.3-4.

After starting Embedded Studio, select [File] -> [Open Solution...] from the menu. When
the project file selection window opens, select a desired project file (*.emProject) and then
click the [Open] button. When the project opens, select a source code from the left pane of
GUI and correct it as needed.

File  Edit  View  Search MNavigate  Project  Build Debug
H New... 0l %
ﬂ Mew Blank File Chrl+E, Ctri+MN > Open Solution ®
=~ <f :
[ Open. Ctrl+O « « 4 ||« ble_app_uartvsspp > pealDB40e 5 112 5 ses v @ O Search ses
Open File From Solution... Alt+Shift+0 de P - o @
Open Studio Folder... 3 ble_app_hts A Name - Tpe
X Close Ctrl+F4 ble_app_ias Output File folder
ble_app_ipsp_scceptol EMPROJECT File
] New Project... Ctrl+Shift+M ble_app_proximity
- . y ble_spp_pwr_profilin
Z] Open Solution... Crl+Shift+ 0 SSPp-prpreting
ble_app_rscs
Import Project... 4 ble_app_template
] Close Solutien ble_app_tile
ble_app_uart
ble_spp_ustt vsspp
peal0i40e
s112
config
Outout < ®
File name: | ble_app_uart_pca10040e 5112 vsspp.emProject | [Solution Files (*.emProject *.er -

Figure. Opening Project File

The sample software included in Nordic nRF5 SDK is stored in the following folder. "<nRF5
SDK>" indicates the path to the folder where nRF5 SDK was installed.

Table. nRF5 SDK Sample Software Storage Folder

<nRF5 SDK>¥examples¥ble_peripheral
<nRF5 SDK>¥examples¥ble_central

For peripheral device
For central device
<nRF5 SDK>¥examples¥ble_central_and_peripheral For both peripheral and

central devices

Storage folders of various types of sample software exist under the above folders.

Step.3-2 Building Application Program

When coding of an application is completed, perform a build.
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From the Embedded Studio menu, select [Build] -> [Build <project nhame>] to start a
build. When the build is completed normally, "Build complete" is displayed in the lower pane
of GUI.

Build  Debug  Target Tools  Window  Help
i"" Build ble_app_uart_pcal0040e_s112 F7
i
Rebuild ble_app_uart_pcal0040e_s112 Alt+F7

nnnnn FIPE

€ ble_app_uart_pcal0040e_s112 - SEGGER Embedded Studio for ARM V4.30c (B4-bit) - Licensed to — a x

Clean ble_app_ua

File  Edit View  Search  Mavigate Project  Build Debug  Target JTools  Window  Help

Project Explorer || X %

@  Build Solution
Rebuild Solution

] 3 Release |z @ « =2 k:
Clean Solution : #include "bsp_btn ble.h" A
Project ltems | Code | Dot Cinclude "met g gnt "
Solution ‘ble_app_uart_pc:
a4 [7] Project ‘ble_app_uart 26.3K 120.7 #if defined (UART_PRESENT)
4 3 Application 2 7il [15K1 [12 #include "nrf_uart.h”
> &) main.c 15K 13 rondif
#if defined (UARTE_PRESENT)
B sdic_configh #include "nrf_uarte.h”

> (Z1 Board Definition s#endif

> [ Board Support 2 88

b (3 None 3 files #include “nrf_log.h"

#include "nrf_log_ctrl.h”

’ g”zi’:i Sam“ #include “"nrf_log default_backends.h”

b nRF_BLE Services

> ([ nRF_Drivers il #define APP_BLE_CONN_CFG_TAG 1 /=< A ta

> (1 nRF_Libraries 25

» [ nRF_Leg Sfiles #define DEVICE_NAME "MK715x1 Evaluation-Kit” /%< Name ,

» (1 nRF_Segger RTT < ) e - ' )

> (1] nRF_SoftDevice

> [ Segger Startup Fil: ] x

> [ UTF8/UTF16 conw

Show: | Transcript v ¥ Y |Output ¥ v
2 Output Files 2 hd 2

1> Compiling ‘nrf_sdh_ble.c’ L]
3> Compiling ‘nrf_sdh_soc.c’

1> Generating linker script ‘ble_app_uart_pcaléadse_s112.1d*

a]p_uar‘t_p(alme_slli,elf

< >
Disconnected (J-Link) ) Built OK  INS R+W Ln12Col 50

Figure. Building Project

Step.3-3 Writing Application Program

When building of an application is completed, perform writing to the evaluation
/development board. The evaluation board and J-Link are connected to PC by USB
connection. The figure below is connected externals at using MK71521EK1 and J-Link LITE.
The Pin No.1 is connected with the red line of cable.

Pin No.1
Position

MK71521EK1

Pin No.1

g connect to the Pin No.1 with the red line of cable.
Position

Figure. Connecting MK715x1 Evaluation Kit with J-Link LITE
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From the Embedded Studio menu, select [Target] -> [Connect J-Link]. The display at the
bottom of the GUI window changes from "Disconnected (J-Link)" as shown in the following

figure.

Taraet = Tools  Window  Help

#% Connect J-Link
% Disconnect
?,} Reconnect

Attach Debugger

Ctrl+T, C
CideT D

% ble_app_uart_pcal0040e_s112 - SEGGER Embedded Studio for ARM V4.30c (64-bit) -

File  Edit  View  Search Navigate

Project Explorer
.4 Release

Project tems
T Selution ‘ble_app_uart_p
4 [T Project ble_app_ua
a4 = Application 21
> &) main.c
B sdk_config.t
> [ Board Definition
> [ Board Support
> [C] None 3files
> (C] nRF_BLE B files
> (L] nRF_BLE_Service
» (L0 nRF_Drivers 81
> (0 nRF_Libraries :
» [ nRF_Log Sfile:
> [ nRF_Segger_RTT
> (1 nRF_SoftDevice
> [ Segger Startup F
> (10 UTF8/UTF16 con
> &3 Output Files

|

o @ « =
Code Data .

Connected target interface "J-Link"

Project  Build Debug  Terget

x| CZD

Lic

* Copyright (c) 2014 -

ensed to

Tools  Window

20.7K] * All rights reserved.

Help

2819, Nordic Semicenducter ASA

* Redistribution and use in source and binary ferms, with or without modification,
= are permitted provided that the following conditions are met:

= 1. Redistributions of source code must retain the above copyright notice, this

list of conditions and the following disclaimer.

12 | * 2. Redistributions in binary form, except as embedded into a Nordic

Semiconductor ASA integrated circuit in a product or a software update for
such product, must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

<

Show: | Target
ROMTbL[@][@]: E@eAEese,
ROMTbL[@][1]: E@eelece,
ROMTbL[@][2]: E@ea2000,
ROMTbL[@][3]: Eeeesece,
ROMTbL[@][4]: E@e40000,
ROMTbL[B][5]: E@ed1eee,

CID:
CID:
CID:
CID:
CID:
CID:

¥ % |ouput -

B1a5E@aD, PID:
BlesegeeD, PID:
B1a5E@aD, PID:
BlesegeeD, PID:
B1@598aD, PID:
B185988D, PID:

adaBBeac
@@3BBee2
262886083
2@3BBeel
@6aBBIAL
@88BBI25

S5C5-M7
DT
FPB
™
TPIU
ETM

I CortexM4 on J-Link lOCy:\es @ Built OK  INS R+W Ln12Col1

X

x

o

>

Figure. Connecting J-Link with Target Board

From the Embedded Studio menu, select [Target] -> [Erase All] to erase the Flash ROM.

The following message will be displayed in the lower pane of GUI.

Target  Tools  Window

Connect J-Link
Disconnect J-Link
Reconnect J-Link

w4 P

Attach Debugger

Reset J-Link

T i g

Erase All
Upload Range...

Help

Download ble_app_uart_pcal0040e s112
Verify ble_app_uart_pcal0040e_s112

Executing Reset script
Reset: Halt core after

Ctrl+T, C
Ctrl+T, D
Ctrl+T, E
Ctrl+T, H

Ctrl+T, 5
Ctrl+T, L
Ctrl+T, ¥V

Ctrl+T, K

B +. B + dond =i

Ye Y |Output

ALECE BESZTREL

-

TargetInterface.resetAndStop()
reset via DEMCR.VC_CORERESET.

[ =)

Erasing Chip

J-Link: Flash download:

Total time needed: @.877s (Prepare: @.858s, Compare: @.8@@s, Erase: @.8lls, P

CortexM4 on J-Link

= 1,682,083 Cycles

& Built 0K

INS

(Mo editor)

Figure. Erasing Flash ROM

From the Embedded Studio menu, select [Target] -> [Download <project name>] to
perform writing to the Flash ROM. The application program and SoftDevice will be written.
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When writing is completed, "Download successful" will be displayed in the lower pane of
GUI, and the written application program will be executed automatically.

Target  Toocls  Window  Help
] " Connect J-Link Ctrl+T, C
%% Disconnect J-Link Ctrl+T, D
% Reconnect J-Link Ctrl+T, E
IE Attach Debugger Ctrl+T, H
. % Reset)-Link Ctrl+T, S
" 1= Download ble_app_uvart_pcal0040e_s112 Ctrl+T, L
. &= Verify ble_app_uart_pcal0040e_s112 Ctrl+T, ¥
: Qutput ~

d-link.

[ ——

- Y

Programming 38.1 KB of addresses @@@1960& — @0@2039b
Programming @.1 KB of addresses @8e2e89c — 68820983
J-Link: Flash download: Bank @ @ exeeeeeeee: 1 range affected (32768 bytes)

F1=MMQaﬁ: Total time needed: @.71@s (Prepare: ©.897s, Compare: @.888s, Erase: @.808s, P

l Download successful

>

L

Disconnected (J-Link) ) Built OK

IN5  R+W Ln12 Col 50

Figure. Writing Program with Embedded Studio

Step.3-4 Writing Built Program

Programmer of nRF Connect for Desktop installed by Step.2-4 is used for writing builded
application program and SoftDevice. The connection of the evaluation board and J-Link

LITE is similar to Step.3-3.
First of all, Programmer is started from nRF Connect for Desktop, Programmer is connected

with J-Link LITE by "Select device" on the left of GUI.

S nRF Connect v3.4.1 - Programmer

Select device ~

AU0T3MNY
« Serial port: COM15

000050108369

File memory layout

re HEX files here

Log
23:29:08.563 Application data folder: C:\Users\a260664\AppData\Roaming\nrfconnect\pc-nrfconnect-pre
23:29:08.802 Using nrfjprog library 10.9.0, pe-nrfjprogs 1.7.3

= ]=] ]

3

@ Add HEX file

C Reload files

© Clearfiles

Device

Figure. Connect Programmer and J-Link LITE
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Next, the application program and SoftDevice are read to Programmer. The [Add HEX file]
button in the window is pressed, the HEX file of the application program and SoftDevice is
selected. The memory layout of the HEX file is displayed in the "File memory layout" area
when succeeding in reading the HEX file.

B rRF Connect v3.4.1 - Programmer - m] x
Select device ~ @
v N File
Device memory layout File memory layout
& Add HEX file
C Reload files
@ Clear files
Device
_ & Erasea
\ J o
# Erase & write
HY Save asfile
Log =fa] |
23:00:40.520 Parsing HEX file: C:\Nordic\nRF5 SDK\nRF5_SDK_17.0.0_9d13099%\examples\ble_periphe * ® Reset
23:09:40.568 File was last modified at 2020/6/13 5:52:34
23:09°40 871 SoftDevice detected, id 0xCB (5132 v7.0.1) /7 Write
13 -

Figure. Read application program / SoftDevice with Programmer

The sample software included in Nordic nRF5 SDK is stored in the following folder.

Table. nRF5 SDK Sample Software Storage Folder

<nRF5 SDK>¥examples¥ble_peripheral For peripheral device
<nRF5 SDK>¥examples¥ble_central For central device
<nRF5 SDK>¥examples¥ble_central_and_peripheral For both peripheral and
central devices
"<nRF5 SDK>" indicates the path to the folder where nRF5 SDK was installed.

The HEX file of the application program is prepared in the "hex" folder under two
hierarchies of the above-mentioned folder.
[Example]<nRF5 SDK>¥examples¥ble_peripheral¥ ble_app_alert_notification¥hex

Refer to the manual attached to each sample software For HEX being offered from LAPIS
Technology.

MK715x1 Software Development Flow (Rev.04 Nov. 30, 2020) 14
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Because the HEX file of Nordic sample software is included of application program and
SoftDevice, the reading operation is executed once. But, Programmer needs to add the HEX
file for SoftDevice because the created HEX file according to Step.3-2 procedure does not

include SoftDevice

The HEX file of SoftDevice is stored in the following folder. Identification number of
SoftDevice of application program is confirmed, and SoftDevice is selected.

SoftDevice folder : <nRF5 SDK>¥components¥softdevice¥sXXX¥hex
SoftDevice HEX file: sXXX_nrf52_Y.Y.Y_softdevice.hex
“<nRF5 SDK>" is installed folder path for RF5 SDK. "XXX" and "Y.Y.Y" are identification

number and version for SoftDevice.

Next, the application program and SoftDevice are written from Programmer. Writing is
executed by [Erase & write] button. Writing is completed after a few seconds pass, and the
memory layout of the written program is displayed in the "Device memory layout" area.

E nRF Connect v2.4.1 - Programmer

000050108369 ~ @

4 A File
NRF52832 © File memory layout

@ Add HEX file
C Reload files

@ Clearfiles

_ _ -
& Eraseall

\. J N
# Erase & write

Log En B Save asfile
R e o e S e e emm it e eam i e s e

23:37:55.360 Core0: Non-volatile memoary has been read. 4 non-empty memory blocks identified - ® Reset
23:37:55.516 SoftDevice detected, id 0xCB (S132v7.0.1)

23:37.55.519 SoftDevice detected, id 0xCB (8132 v7.0.1) # Write

13 -

Figure. Write Application program / SoftDevice with Programmer
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Finally, Programmer and J-Link LITE are disconnected by [Close device] on the left of GUI of
Programmer.

E nRF Connect v2.4.1 - Programmer

000050108369 ~ @

AUDT3MNY
= Serial port: COM15

000050108369 File memory layout

Close device @ Add HEX file
C Reload files

@ Clearfiles

- - -
] ¢ Eraseall

7/ Erase & write

Log n B Save asfile
.......... e o e S e e emm it e eam i e s e

00:07:04.652 Corcu. Won-volatile memary has been read. 4 non-empty memory blocks identified - ® Reset
00:07:04.807 SoftDevice detected, id 0xCD (5112 v7.0.1)

00:07:04.809 SoftDevice detected, id 0xCD (S112 v7.0.1) - # Write

a 13

Figure. Disconnect to Programmer and J-Link LITE

Step.3-5 Checking the Operation of Application Program

Check the operation of an application program. "BLE Tool", which is the application for
smartphone/tablet terminal, is available for the case of using LAPIS Technology's sample
software for serial communication. Refer to the following link and download the application

to a smartphone/tablet terminal as needed.

For "nRF Connect for Mobile" which is the application for Nordic smartphone/tablet terminal,

refer to the following link.
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Conclusion

The whole image of the software development environment that has been explained so far
is shown below. Of course, the customer's board for the peer device can be used though the

peer device is the smartphone.

Download & debugging of customer

€>»| 1-Link €| Evaluation Board

PC

-IDE(SEGGER Embedded Studio, etc.)

-Tools for development(nRF Connect for Desktop, etc.)
-Nordic nRF5 SDK

-Sample software

-Application for smartphone
(BLE Tool.
nRF Connect for Mobile, etc.)

Figure. Software Development Environment
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